
Read Me

Pro Tools LE 8.0.4 on Mac

This Read Me documents important compatibility information, known issues, error codes, and corrections to the guides for 
Pro Tools LE 8.0.4 on qualified Mac computers running either Mac OS X 10.6.3 (Snow Leopard) or Mac OS X 10.5.5 
(Leopard).

Compatibility
Avid can only assure compatibility and provide support for qualified hardware and software configurations. For a list of qual-
ified computers, operating systems, and third-party devices, refer to the latest compatibility information on the Avid website 
(www.avid.com/compatibility).

Pro Tools Cannot Record To Drives Formatted as Case-Sensitive (Item #PTSW-64502)

Pro Tools cannot record to Mac OS X drives which have been formatted as “Case-Sensitive.” Format the Mac OS X record vol-
umes as “Mac OS X Extended (Journaled)” in order to record properly.

Known Issues
The following section documents known issues you may encounter when using Pro Tools 8.0.4 on Mac OS X 10.5.5 (Leopard) 
or Mac OS X 10.6.3 (Snow Leopard) or along with workarounds if they exist.

Pro Tools

Synchronizing to External Clock with a Different Sample Rate from the Session Results in the Following Error: “The current 
playback engine does not support a sample rate of 44.1 kHz” (Item #PTSW-127065)

In certain circumstances, attempting to synchronize to an external clock that has a different sample rate than the session may 
result in the following error: “The current playback engine does not support a sample rate of 44.1 kHz.” On Mac OS X, this 
may be preceded by the error “Pro Tools has re-set the sample rate of the HW device because it was changed by another ap-
plication.” If this happens, correct the sample rate mismatch and re-select the correct clock rate. 

Pro Tools Menus and Interface are Grayed Out on Launch (Item #PTSW-18024)

Pro Tools can appear unresponsive at launch, with the Menus grayed out and browsers inoperable. This can happen because 
of Spaces. If Pro Tools is launched in any other Space than the first one, the Session Quick Start dialog still opens in the first 
Space. You can temporarily disable Spaces, launch Pro Tools and disable the Session Quick Start dialog in the Preferences to 
avoid this problem.

Some Shortcuts Can Conflict with System Keyboard Shortcuts (Item #PTSW-125894)

Control-Option-Command-' (apostrophe) and Shift-Control-Option-Command-' (apostrophe) can conflict with system key-
board shortcuts (Snow Leopard only). If a conflict occurs, moving a playlist selection or extending a playlist selection will not 
function if Apple Menu > System Preferences > Keyboard > Keyboard Shortcuts > Keyboard & Text Input > “Move Focus to 
window drawer” is enabled. 

For known issues specific to any of the Toolkit options for Pro Tools LE, see the Complete Production Toolkit Read Me, the 
DV Toolkit 2 Read Me, or the Music Production Toolkit 2 Read Me accordingly.
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To avoid this conflict, disable the “Move Focus to window drawer.” The selection commands will now work.

Launching Pro Tools Results in a “Digidesign Hardware is in Use by Another Application” Error Message 
(Item #PTSW-64502)

There are known issues with CoreAudio and Mac OS X 10.5.3. Setting your computer's audio Input in the Mac OS X System 
Preferences to Digi HW causes the Digidesign Core Audio Manager to launch whenever you open the Mac OS X Sound Pref-
erences. You must quit the CoreAudio Manager before you can launch Pro Tools. To avoid this problem, do not set the audio 
Input to Digi HW in the Mac OS X System Preferences.

Templates Retain I/O Settings and Some Preferences, Display Settings, and Window Layouts (Item #PTSW-47133)

Pro Tools Session Templates Retain the I/O settings and some of the preferences, display settings, and window layouts from 
the system on which the template was created. Consequently, created a new session based on a template restores several ses-
sion properties from the original system. These properties are retained by Pro Tools until you change them or another session 
or template is opened that replaces them. This also means that if a new blank session is created after using a template, the 
properties from the template will be used for the new session.

The properties retained from templates include default track height, view settings, window size and position, and I/O Setup. 
You can update templates by making the desired changes, using the File > Save as Template command (be sure to select the 
“Install template in system” option), and then selecting the template you want to replace.

Opening Session Created with Pro Tools 7.4 or Lower (Item #PTSW-21173)

When opening sessions created with Pro Tools 7.4 or lower in Pro Tools 8.0 or higher, all waveform overviews are recalcu-
lated. This is because Pro Tools now features 16-bit waveform overviews, so all old 8-bit overviews will need to be recalculated. 
This recalculation only needs to happen once.

Possible Performance Issues with New Waveform Overviews (Items #110041, 106801, and 106577)

Calculating waveform overviews in Pro Tools 8.0 or higher may cause some one time issues with various operations. Once the 
overviews are calculated, system performance will return to normal. Areas where you may notice this are:

Legacy Sessions (Item #PTSW-23862) When opening Legacy Pro Tools sessions for the first time, if you immediately start 
playback, you may encounter various errors advising you to increase the H/W Buffer size, or to delete tracks, or to remove 
some RTAS plug-ins. This is due to the fact that Pro Tools is re-calculating of the session’s waveform overviews in the back-
ground. Pausing this task in task manager, or waiting until this task is complete, will resolve the issue. Once the waveform is 
calculated, you will not experience this issue again.

Playback of Newly Created Regions (Items #PTSW-21224 and PTSW-21224) You may notice a slight drop in normal playback 
performance immediately following a record take or after creating or importing new regions. This is due to the fact that 
Pro tools is calculating waveform overviews in the background, and is mostly only encountered when recording or creating 
many regions with long durations. Pausing this task in task manager, or waiting until this task is complete, will resolve the 
issue. Once the waveform is calculated, your session playback performance will return to expected levels.

Spotlight Indexing Can Interfere With Long Record Passes (Item #PTSW-17055)

There are known incompatibilities with Spotlight indexing drives while recording audio. If you will be recording to a large 
number of tracks for over an hour, set all of your drives to private in the Mac OS X System Preferences to ensure maximum 
performance. Failure to do this may result in Pro Tools reporting an error and ending the record pass when Spotlight indexes 
the drives.

CPU Usage Limit May Be Reached when Error Suppression is Enabled (Item #PTSW-50339)

When enabling Error Suppression at CPU Usage Limit 85% or higher, it may be possible to overload your computer to a point 
at which it is no longer recoverable. To avoid this state, keep your CPU Usage Limit set to 80% or lower when Error Suppres-
sion is enabled.
Pro Tools LE 8.0.4 on Mac — 6/10/10 2



Software Instrument Does Not Emit Sound when Inserted on an Instrument Track or Auxiliary Input (Item #65797) 

Some third-party software instruments will not emit sounds and will not play unless they have a valid hardware input or 
MIDI output assignment. If this occurs, manually assign a hardware input to the Instrument track or Auxiliary Input, and/or 
manually assign a MIDI output to the Instrument.

Audio Regions on Tick-Based Tracks Do Not Play at the Correct Tempo after Opening a Reason Song with a Different Tempo 
(Item #PTSW-34086)

Audio regions on tick-based tracks do not play at the correct tempo after opening a Reason song with a tempo that is different 
from the one in your session. To correct this, make any tempo change via the Conductor track or the Manual Tempo input 
and the regions will play back correctly.

Opening a Session with a QuickTime Movie as a Non-Administrator User Can Prevent the Movie from Playing Back 
(Item #47053)

If you open a session as a non-administrator user and you do not have permissions for the QuickTime movie file, Pro Tools 
will tell you that the movie file cannot be found and prompt you to relink. In the relink window the movie can be found and 
Pro Tools will appear to relink to it but it will still not play back. For correct playback, make sure you have permission to use 
the QuickTime movie file.

MP3 Codec Exports Non-Copyright Files Only (Item #PTSW-65975)

The MP3 codec in Pro Tools 7.3 and higher does not have the ability to encode an attribute for the file to be copyrighted. This 
is a limitation of the codec from Fraunhofer. 

Some QuickTime Audio Formats Cannot Be Imported (Items #58792 and PTSW-52226)

The audio from QuickTime movies with Apple Lossless or AMR audio compression cannot be imported into Pro Tools. Use 
QuickTime Pro or another application to convert the audio to another format prior to import.

Apple Lossless Codec Is Not Supported for Bounce to QuickTime Movie (Item #PTSW-53198)

Pro Tools 7.3 and higher does not support the Apple Lossless audio codec. Choosing it from the Bounce to QuickTime Movie 
Audio Compression dialog will result in a movie without usable audio.

Automation Window Update when Writing Automation (Item #PTSW-46747)

When writing automation on Volume, Pan, and so on, the corresponding buttons in the Automation window provide no in-
dication that automation on the related control is being written. You will need to observe the automation buttons on tracks 
in Mix or Edit windows to see an indication that automation is being written.

File and Disk Management

Missing Files when Opening a Session that Was Saved Using Save Copy In with Preserve Folder Hierarchy 
(Item #PTSW-52860)

The Preserve Folder Hierarchy feature is designed so that sessions with media split between multiple volumes can be easily 
moved between systems while retaining folder hierarchy. In order for media files to be automatically found, manually copy 
or create a folder at the root level of each volume with the session name that contains the Audio Files or Video Files folder. 
Or, manually relink to the missing files at their current location. 

Session Copy Saved with Preserve Folder Hierarchy in which Multiple Files Have the Same Name Does Not Relink Properly 
(Item #PTSW-29069)

When saving a session copy with Preserve Folder Hierarchy checked, files with the same name may not relink properly when 
using Manual Relink. When opening the session copy, use Automatically Relink to locate the correct files. If the session has 
already been opened using Manual Relink and some files are still offline, select Relink Offline in the Project Browser to man-
ually relink the remaining files.
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MIDI

When Recording MIDI, Wait for Note Does Not Respond to MIDI Input from Rewire (Items #PTSW-30511 and PTSW-34550)

When performing a MIDI record, Wait for Note will not respond to any MIDI received from Rewire. If you are recording MIDI 
generated from a Rewire application, you will have to start the transport manually or use a countoff instead of Wait for Note.

When Using Import Session Data on a MIDI Track with Real-Time Properties Enabled and Set to Using Diatonic 
Transposition, Transposition is Based on the First Key Signature in the Session Only (Item #PTSW-49297)

When importing session data from a session that includes multiple key signatures and a MIDI or Instrument track with the 
“Transpose in Key” Real-Time property enabled, the transposition will be based only on the first key in the session. This can 
be corrected by toggling the Real-Time Properties off and on, at which point the diatonic transposition will be correct for each 
key.

Unavailable MIDI Input Paths for MIDI and Instrument Tracks are not Indicated (Item #PTSW-46839)

The device or path name for MIDI Input on MIDI and Instrument tracks is not italicized and grayed out when opening a ses-
sion on a system where the device or path are not actually present.

Elastic Audio

Change Between Pro Tools 7.4 and 8.0 in how Transient and Warp Markers Affect Sound Quality (Item #PTSW-20012)

Both the Polyphonic and Rhythmic Elastic Audio algorithms rely on transient analysis to achieve optimal fidelity and timing 
accuracy. Reducing event sensitivity, and consequentially removing Analysis or Warp markers, may adversely affect the 
sound quality and timing of elastic regions. Conversely, an overabundance of Analysis markers or Warp markers, can also ad-
versely affect sound quality. For best results, make sure that Analysis markers are reasonably correct vis a vis the musical 
events in an audio region. Note that to achieve the highest sound quality, the Polyphonic algorithm in Pro Tools 8.0 and 
higher is more reliant upon Analysis markers than in Pro Tools 7.4.

Unusual Audio “Warble” with Polyphonic Elastic Audio (Items #PTSW-18647 and PTSW-22817)

In some cases, some audio that is being processed with the Polyphonic Elastic Audio algorithm may sound “warbly.” If this 
occurs, try adjusting the Window Length control in the Polyphonic Elastic Audio Plug-in window until the warble goes away. 
If you are opening a session that previously used the default Window Length setting in Pro Tools 7.4.x, which was 30 ms, a 
recommended starting point would be 40 ms. 40 ms is also the new default parameter value for the Polyphonic Elastic Audio 
algorithm in Pro Tools 8.0 and higher.

Real-Time Elastic Audio Tracks Do Not Show Accurate Waveforms (Item #PTSW-35208)

When using Elastic Audio Real-Time Processing, Pro Tools displays the varispeed waveform in Waveform view no matter 
which algorithm you are using. This is done because all of the Elastic Audio processing is done in real-time and the waveform 
is a prediction of what it will sound like. Switching to Rendered mode will give you an actual representation of the audio as 
rendered by the algorithm you are using.

Drift in an Audio File May Occur when Using Elastic Audio and the Monophonic or X-Form Algorithms (Item #PTSW-33768)

Drift in an audio region may occur when using elastic audio depending on how much the regions is expanded or compressed 
when using the Monophonic or X-Form algorithms. If you are using elastic audio with material that contains transient in-
formation in it that you would like to keep from drifting, you should use the Polyphonic or Rhythmic algorithms.

Maintaining Phase Coherency with Elastic Audio Pitch Processing (Item #PTSW-20602)

When there is Elastic Audio Pitch processing enabled on a track, switching from Polyphonic, Rhythmic, or X-Form to Mono-
phonic or Varispeed can disrupt phase coherency. To preserve phase coherency in this case, be sure to clear all Elastic Audio 
Pitch processing from the track before switching to the Monophonic or Varispeed algorithm.
Pro Tools LE 8.0.4 on Mac — 6/10/10 4



Certain Audio Files Cannot Be Calculated or Cleared of Elastic Analysis in Workspace Browser (Item #PTSW-29622)

There are some rare cases where a file will have a file suffix of a file format supported by Elastic Audio (either .WAV or .AIF), 
but the Pro Tools Workspace Browser will not allow calculation or clearing of elastic analysis. The browser menu items Cal-
culate Elastic Analysis and Clear Elastic Analysis will be greyed out. In these cases, the file may actually be in a non-supported 
format. To check the file’s format, look at the Format column in the Workspace browser. If a file format other than WAV or 
AIFF is shown (such as QuickTime), then the file cannot be calculated or cleared of elastic analysis. Note that these non-sup-
ported files can still be previewed in tempo, as well as elasticized once imported into a session.

Tempo Maps Made from Bar|Beat Marker Generation in Beat Detective Cause Region Groups in Rendered Mode to Fall 
Offline (Item #PTSW-34950)

A tempo map made from Bar|Beat Marker Generation in Beat Detective will cause region groups in Rendered mode to fall off-
line. The workaround is to make an edit to the offline region and then toggle the Elastic Audio from rendered to real-time and 
then back to rendered.

Default Input Gain Preference Is Only for Elastic Audio Imported at Session Tempo (Item #PTSW-34096)

The Default Input Gain preference in the Elastic Audio section of the Processing Preferences page is for Elastic Audio Imported 
at Session Tempo only. This preference option will not function unless Preview in Context is enabled in Workspace, and/or 
“Drag and Drop from Desktop Conforms To Session Tempo” is enabled in the Processing Preferences page.

Displayed Timebase is Incorrect after Importing Elastic Audio Tracks (Item #PTSW-46897)

The incorrect timebase is displayed after importing Elastic Audio tracks to existing tracks with opposite timebase. You will 
need to manually select the correct timebase for the affected tracks.

Elastic Audio Regions on Playlist Lanes Are Not Rendered (Item #PTSW-47311)

In Playlists View, any Elastic Audio regions on Playlist lanes are not rendered (waveform is “off-line”) when changing the 
track’s Elastic Audio processing from Real-Time to Rendered.

Region Groups Containing Elastic Audio Are Not Recognized as Elastic if the Region Group Itself Has Not Had Any Elastic 
Functions Applied (Item #PTSW-34335)

If a region group contains Elastic Audio inside it, but no Elastic Audio operations have been performed on the outermost level 
of the region group itself, then the region group will not register as Elastic Audio. When used to create a new track, the track 
will not automatically be Elastic Audio–enabled, and the elastic audio inside the region group will be rendered using the de-
fault Elastic Audio plug-in for the session. As a workaround, add a warp marker to the region group to force it to register as 
an elastic region. Or, create an Elastic Audio–enabled track first, then add the region group to it.

Cannot Import Elastic Audio Tracks with the Consolidate From Source Media Option (Item #PTSW-33894)

Use Copy from Source Media to import Elastic Audio tracks. 

Timing Inaccuracy in Audio Files Converted from CAF and MP3 with Preview In Context Enabled (Item #PTSW-46707)

Audio files converted from CAF and MP3 with Preview In Context enabled can cause timing inaccuracies (gaps in the audio 
and inner-region asynchronous transients issues). This is inherent with compressed file formats.
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Plug-ins

AudioSuite and Region Groups (Item #PTSW-57457)

AudioSuite plug-ins handle Region Groups in the Region List slightly differently than audio files. With audio files, an Audio-
Suite process can be applied to all copies of a unique audio file which appear in your session by selecting your target as Region 
List in the AudioSuite plug-in window and selecting Use in Playlist. However, if your target is set to Region List in the Audio-
Suite plug-in window while you have a Region Group selected, Pro Tools does not recognize the Region Group as processable 
audio and will present a No Audio was Selected error. This is because a Region Group is not treated as audio until it is actually 
used in a track.

To apply an AudioSuite process to all copies of a Region Group in a session at once, do the following:

1  Select the Region Group to be processed.

2  From the Region List menu, select Ungroup All. All elements of the group will remain selected.

3  Perform AudioSuite processing.

4  From the Region List menu, select Regroup.

When prompted, select Modify to apply the AudioSuite Process to all copies of the Region Group in the session, or Copy to 
apply it only to the selected Region Group.

Hybrid User Interface Shows Distorted Bright Colors (Item #PTSW-127467)

The version of Hybrid that is installed with Complete Production Toolkit may show up with incorrect coloring in OS 10.6 
(Snow Leopard). Install the latest update of Hybrid to correct this. You can download the latest version from: 
http://avid.custkb.com/avid/app/selfservice/search.jsp?DocId=362871

Control Surfaces

Trim Scrub and Trim Shuttle Don’t Work on Regions with Fades (Item #PTSW-46911)

If a region has fades, Trim Scrub and Trim Shuttle don’t work when trying to trim using a control surface. To work around 
this problem, remove any fades on the region, then execute the Trim Scrub or Trim Shuttle, and then restore the fades.

Axiom Pro HyperControl “F” Keys for Track Select, Mute, and Solo, and for Loop Playback Toggle Do Not Function After 
Restarting Pro Tools (Item #PTSW-128808)

After restarting Pro Tools, certain keys do not function in HyperControl including Track Select, Mute, Solo, and Loop Play-
back Toggle. On Axiom Pro 49 and Axiom Pro 61, (but not Axiom Pro 25) use buttons S10 through S17 for Track Select, Mute, 
and Solo. Otherwise, you can use the mouse for these functions. 

Video

Unsupported QuickTime Video Formats (Items #PTSW-52140, PTSW-52155, PTSW-52156, 72961)

Several video formats supported in QuickTime are not supported in Pro Tools. These include .DivX, .flc, .m4v and .3gp format 
movies. Attempting to import these will generate errors or will fail to import.

Standard Definition QuickTime Movies Are Rendered as 16:9 Anamorphic Play Back in Pro Tools at 4:3 
(Item #PTSW-23020)

Standard Definition QuickTime movies rendered with 16:9 an anamorphic Scaled Size of 853x480 play back in Pro Tools at 
4:3 or 720x486 resolution. The Scaled Size attribute of QuickTime movies is ignored by Pro Tools. To workaround this prob-
lem, render the movie letterbox natively within the 720x486 pixel dimension.

For known issues about specific plug-ins, see the Digidesign Plug-ins Read Me.
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Dragging from Mac Finder in Shuffle Mode Does Not Work Correctly with Video (Item #PTSW-28041)

Dragging a Video file from the desktop to the Edit window while in Shuffle mode will always place the video at session start, 
overwriting existing video regions in that location.

Pro Tools UI May Slow Down with Densely Edited QuickTime Movie Track (Item #PTSW-54496)

Pro Tools may begin to respond more slowly and update less often as a session with one or more QuickTime video tracks be-
comes more and more densely edited. If, while working with heavily edited QuickTime clips, Pro Tools responsiveness begins 
to decline, use the Bounce to QuickTime Video command, then import the bounced movie.

MPEG-1 and MPEG-2 Video Freezes at Edit Points (Item #PTSW-55185)

Editing MPEG-1 & MPEG-2 video is not officially supported. If you experience this problem, try switching playback to the 
Video window, or convert the movie to a supported format using a 3rd party application. Removing the audio from an MPEG-
1 or MPEG-2 movie with a 3rd party application may also fix the problem.

Audio from “Muxed” MPEG-1 and MPEG-2 Movies Cannot Be Imported and Will Be Heard in a Bounced Movie 
(Item #PTSW-53625)

Unlike other QuickTime formats, MPEG-1 and MPEG-2 movies store audio and video in a single multiplexed track, called a 
“muxed.” track. Pro Tools cannot separate the audio from video for these types of movies. As a result, you will not be able to 
import the audio from an MPEG-1 or MPEG-2 movie. Also, if you Bounce to QuickTime using an MPEG-1 or MPEG-2 movie 
as a source movie, the original audio from the movie will be present in the bounced movie (even though it will not be heard 
while working with the movie in Pro Tools). To import audio from an MPEG-1 or MPEG-2 file, use a third party application 
to “demux” the MPEG stream.

When Using Bounce to QuickTime, Do Not Bounce to an Existing Movie Name (Item #PTSW-53967)

If you use the Bounce to QuickTime command and use the same name as an existing movie, the bounce may fail. It is best 
to use a unique name for each bounce, or delete the previous movie from the drive prior to bouncing with the same name 
(rather than choosing to replace the existing file).

System Instability when Running Multiple Applications Using Blackmagic Design Hardware for QuickTime Video Output 
(Item #PTSW-19486)

When Pro Tools is running with a Blackmagic DeckLink II Extreme or Intensity video capture and playback PCI-e card in-
stalled, launching Blackmagic Design’s Deck Capture utility, Final Cut Studio, or any other application which supports Black 
Magic hardware for video output, can result in system instability. To avoid any potential system instability only use one 
Blackmagic DeckLink–aware application at a time.

Performance Issue with BlackMagic Quicktime Playback Card on Mac OS 10.6–10.6.2 with a “Harpertown” and Previous 
Generation Mac Pros (Item #120184)

When using a Blackmagic Quicktime playback card (Decklink or Intensity) on “Harpertown” and previous Mac Pros with Mac 
OS 10.6–10.6.2, the video output may drop frames at certain frame rates. To avoid this issue, use Mac OS 10.6.3 or Mac OS 
10.5.8 (Leopard). This issue does not occur with the newer “Nehalem” Mac Pros.

CoreAudio

Mbox Is Not Available as a CoreAudio Client (Item #PTSW-17692)

Selecting Mbox as a CoreAudio client in the Mac OS X System Preferences may not stick after closing the System Preferences. 
Try restarting your computer and then re-selecting Mbox in the System Preferences to correct this.
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Digidesign Hardware May Not Play Sound from QuickTime or Safari with CoreAudio (Item #PTSW-3093 and PTSW-27892)

If you do not hear sound when playing back audio through Digidesign hardware from QuickTime or Safari with the Digi 
CoreAudio Manager, try one the following:

• Open the Mac System Preferences and click Sound. While QuickTime or Safari is playing back audio, change the Output 
from Digidesign HW to Internal, and then back to Digidesign HW.

– or –

• Launch iTunes before launching QuickTime or Safari.

General Localization 

Session Notes or Session Info Text Files Saved in Japanese May Not Open in TextEdit (Item #PTSW-46686)

Session Notes (you can generate these if you are missing plug-ins or have problems when opening a session) or Session Info 
(File > Export > Session Info as Text) text files may not open in TextEdit, depending on the TextEdit preference settings. This 
is because the files use different text encoding. As a workaround, you can use the Console application to open files or you can 
use the Open menu item in TextEdit, then choose the correct encoding, as follows:

• Session Notes - UTF-8

• Session Info - Japanese (Mac OS)

Certain Chinese Characters Need to Be Initiated in the Mac OS Before They Can Be Used for Naming in Pro Tools 
(Item #PTSW-33074)

If you cannot use certain characters for naming in Pro Tools, use Text Edit in Mac OS X to initiate the characters. In Text Edit, 
type the same characters you were trying to use, then use the mouse to select the correct ones from the pop up menu. You 
should now be able to use them in Pro Tools.

003 Family and 002 Series Interfaces

Reconnecting an 003 or 002 After Losing the Connection with Pro Tools (Item #PTSW-20351)

If your 003 family or 002 series interface looses its connection with Pro Tools, increasing your buffer size or changing your 
CPU usage limit may bring the device back online without having to close Pro Tools or restart your computer.

Importing .PIM Files on an 003 System with a C|24 (Item #PTSW-46401)

When importing a custom map .PIM file created on a 003 to another 003 system with a C|24, 003 displays “<No Track>” on 
the scribble strips instead of staying in Plug-in Edit mode with a restored newly imported Plug-in Map. You will need to 
switch to another mode on 003 and then re-enter Plug-in Edit mode to correct this.

Error Messages

Error –6042

If you repeatedly encounter –6042 errors, open the System Usage window and check the PCI gauge. If the gauge is peaked, you 
will need to reset the PCI bus. To reset the PCI bus, make all tracks inactive and start playback. If you still encounter a –6042 
error, quit and relaunch Pro Tools, open the Playback Engine dialog, and change the Number of Voices to a setting that uses 
fewer voices per DSP. 

DAE Error –9073 Without Reaching the 2 GB File Limit

If you encounter a –9073 error, and you have not reached the 2 GB file size limit, please refer to the Answerbase for possible 
causes and solutions (http://answerbase.digidesign.com).
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DAE Error –9128

In sessions with high sample rates (96 kHz or higher), you may need to set the Hardware Buffer Size to 512 or more to avoid 
–9128 errors during playback with RTAS plug-ins or dense automation.

DAE Error –9131 (Items #92747, #20843)

GUID partitioned drives will not allow you to record beyond the third partition when running on OS X. A workaround is to 
partition audio drives using Apple Partition Map instead of GUID.

– or –

Recording to or playing from a UNIX File System (UFS) formatted drive is not supported in Pro Tools.

DAE Error –9132 (Item #32397)

If a –9132 error occurs during Bounce To Disk (even with the highest Hardware Buffer setting selected), bus the appropriate 
tracks to the appropriate number and format of audio tracks, and record to disk. You can then use the resulting audio files as 
you would have used bounced files.

DAE Error –9155

In sessions with high sample rates of 96 kHz or more, you may need to set the Hardware Buffer Size to 512 or more to avoid 
–9155 errors during playback with dense automation.

DAE Error –9735

When Pro Tools reaches the end of its time limit in the session Timeline, or if Pro Tools has been in continuous play for 
longer than the maximum time limit, you will encounter a DAE error –9735. The maximum time limit for Pro Tools depends 
on the session sample rate. For more information, see the Pro Tools Reference Guide.

Corrections to Pro Tools Guides

What’s New Guides
Part Number 9320-59102-00 REV A 11/08

The following identifies corrections to and omissions from both the What’s New in Pro Tools LE and M-Powered 8.0 Guide.

Time Locking Regions

On page 38 of the What’s New in Pro Tools LE and M-Powered 8.0 Guide, the keyboard shortcut tip for Time Locking regions in-
correctly states, “Press Shift+T to Time lock or unlock the selected region.” 

Corrections:

The keyboard shortcut tip should read, “Press Alt+Start+L (Windows) or Option+Control+L (Mac) to Time lock or unlock the 
selected region.”

Pro Tools Reference Guide
Part Number 9106-59126-00 REV A 11/08

The following identifies corrections to and omissions from the Pro Tools Reference Guide.

Toolbar Focus

On page 25 of the Pro Tools Reference Guide, documentation of Toolbar focus is incorrectly omitted.
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Corrections:

The following section for “Toolbar Focus” should be added right after the section on “Keyboard Focus:”

Toolbar Focus

In the Edit window, the MIDI Editor pane can be displayed in addition to the Tracks pane (View > Other Displays > MIDI Editor). 
When the MIDI Editor pane is displayed, there are two separate Toolbars and Timelines in the Edit window: one for the Tracks 
pane and one for the MIDI Editor pane. Only one Toolbar and Timeline can be focused for Menu and Toolbar commands (in-
cluding the corresponding keyboard shortcuts) at a time. The focused Toolbar displays a orange outline. 

If Keyboard Focus for the Edit window is enabled, it follows the selected Toolbar focus.

To enable Toolbar focus for the Tracks pane, do one of the following:

Click the Toolbar at the top of the Edit window.

– or –

Press Control+Alt+4 (Windows) or Command+Option+4 (Mac).

To enable Toolbar focus for the MIDI Editor pane, do one of the following:

Click the Toolbar right above the MIDI Editor pane.

– or –

Press Control+Alt+5 (Windows) or Command+Option+5 (Mac).

Pro Tools LE System Capabilities

On page 34 of the Pro Tools Reference Guide, the final paragraph incorrectly states, “Pro Tools LE systems provide up to 128 
Auxiliary Input tracks, a total of 32 internal mix busses, and up to 5 inserts and 10 sends per track (depending on your com-
puter’s processing capacity). In addition, Pro Tools LE systems support up to 32 Instrument tracks and 256 MIDI tracks. 
Pro Tools LE also supports a single QuickTime video track.”

Corrections:

The paragraph should read, “Pro Tools LE systems provide up to 128 Auxiliary Input tracks, a total of 32 internal mix busses, 
and up to 10 inserts and 10 sends per track (depending on your computer’s processing capacity). In addition, Pro Tools LE sys-
tems support up to 32 Instrument tracks and 256 MIDI tracks. Pro Tools LE also supports a single QuickTime video track.”

Zoom Toggle Preferences

On page 90 and also on page 455 of the Pro Tools Reference Guide, the paragraph on the “Separate Grid Settings When Zoomed 
In” preference incorrectly states:

Separate Grid Settings When Zoomed In When selected, this option retains the same (current) grid setting when zoom tog-
gling in or out. When this option is deselected, the grid setting stored with Zoom toggle is recalled when zoom toggling in. 

Corrections:

The paragraph should read:

Separate Grid Settings When Zoomed In When selected, the Grid setting stored with Zoom toggle is recalled when zoom tog-
gling in. When this option is deselected, the same (current) grid setting is used whether zoom toggling in or out. 

Notes View for MIDI and Instrument Tracks

On page 435 of the Pro Tools Reference Guide, the ability to use a mouse with a scroll wheel to scroll up or down in Notes View 
is omitted.
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Corrections:

The following step should be added to the procedure for scrolling the Notes display up or down for a MIDI or Instrument 
track: “If you have a mouse with a scroll-wheel, move the cursor over the track and Control-Alt-Start-scroll (Windows) or 
Command-Option-Control-scroll (Mac) up or down to scroll the notes display up or down.”

Time Locking Regions

On page 731 of the Pro Tools Reference Guide, the keyboard shortcut tip for Time Locking regions is incorrectly states, “Press 
Shift+T to Time lock or unlock the selected region.” 

Corrections:

The keyboard shortcut tip should read, “Press Alt+Start+L (Windows) or Option+Control+L (Mac) to Time lock or unlock the 
selected region.”

Dragging and Dropping Plug-in Settings Files

On page 891 of the Pro Tools Reference Guide, the section on “Dragging and Dropping Plug-in Settings Files” erroneously states 
that you can drag and drop plug-in settings files from Windows Explorer or the Mac Finder to inserts and plug-in windows. 

Corrections:

The section on “Dragging and Dropping Plug-in Settings Files” should read:

To insert a plug-in by drag and drop:

Drag and drop a plug-in settings file from a DigiBase browser to an Insert in the Mix (or Edit) window.

To change a plug-in preset by drag and drop:

Drag and drop a plug-in settings file from a DigiBase browser to the plug-in window. The plug-in settings file must be for 
the same plug-in name. For example, you cannot replace a 1-Band EQ 3 with a plug-in setting for 4-Band EQ 3.

Menus Guide
Part Number 9329-52920-00 REV A 11/08

Track Menu

On page 33 of the Pro Tools Menus Guide, the following menu items are not available (however, the keyboard shortcuts for 
these items remain functional):

• Solo Tracks with a Selection

• Mute Tracks with a Selection

• Record Arm Tracks with a Selection

• Input Monitor Tracks with a Selection (Pro Tools HD Only)

Corrections:

The entire “Solo, Mute, Record Arm, and Input Monitor Tracks with a Selection Commands” section should be deleted.

Trillium Lane Labs Plug-ins Guide
Part Number 9329-59303-00 REV A 11/08

Introduction

The TL Labs AutoPan™ is incorrectly listed as a paid plug-in, but it is included free and installed with Pro Tools 8.0. 
Pro Tools LE 8.0.4 on Mac — 6/10/10 11



Corrections:

TL Labs AutoPan should be listed under Free Trillium Lane Labs Plug-ins and should be deleted from under Paid Trillium Lane 
Labs Plug-ins.
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